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Trademarks 

The following are trademarks of Motorola:  MOTOTRBO™.  

 

Any other brand or product names are trademarks or registered trademarks of their respective holders.  

The Genesis Group Trademark Information 

GW3-TRBO® is a registered trademark of GenCore Candeo, LTD., a subsidiary of Burks Gencore Co., Inc. 

D.B.A. The Genesis Group and Phil Burks.  

Copyright 

Copyright © 2011; Burks Gencore Co., Inc. D.B.A. The Genesis Group and Phil Burks.  All rights are 

reserved. No part of this publication or the associated program may be reproduced, transmitted, transcribed, 

in whole or in part, in any form or by any means, whether it is mechanical, magnetic, optical, electronic, 

manual or otherwise, without the prior written consent of Burks Gencore Co., Inc. D.B.A: 

The Genesis Group and Phil Burks 

601 Shelley Dr., Suite 202 

Tyler, Texas 75701. 

 

Includes technology licensed from Motorola. 

Disclaimer 

The GW3-TRBO Users Manual is printed in the U.S.A. Burks Gencore Co., Inc. D.B.A. The Genesis Group 

and Phil Burks believe that the information included in this manual is correct; however, Burks Gencore Co., 

Inc. D.B.A. The Genesis Group and Phil Burks reserves the right to alter, revise and make periodic changes 

to the manual and its contents. Burks Gencore Co., Inc. D.B.A. The Genesis Group does not assume 

responsibility to notify any person of such revisions or changes. While we have taken strides to carefully 

examine our software and documentation and believe that it is reliable, the Genesis Group and Phil Burks 

assume no responsibility for the use of the manual, or GW3-TRBO software, nor for any patent infringements 

or other rights of third parties who may use the manual or the GW3-TRBO software. Burks Gencore Co., Inc. 

D.B.A. The Genesis Group and Phil Burks make no representations or warranties with respect to the contents 

or fitness for a particular purpose beyond the cost of the software paid by the end-user. 

 

The software contains valuable trade secrets and proprietary information. Unauthorized use of the manual or 

software can result in civil damages and criminal prosecution. As an end user, you agree to abide by and heed 

these statements. 

License 

Title to the media on which the program is recorded and to the documentation in support of the product is 

transferred to you, but title to the program, and all subsequent copies of the program, despite the form or 

media in or on license is not a sale of the original or any subsequent copy. You assume responsibility for the 

selection of the program to achieve your intended results, and for the installation, use, and results obtained 

from the program. 

 

Refer to the GW3-TRBO Manual Overview for your full license.  All license information contained on pages 

4-7 (Book 600-2.3.0-AA.1) are to be considered as contained herein. 

Support 

Customer satisfaction is our number one priority at Genesis.  We are here to provide you with the best 

software possible, and we want to know when you have any questions, concerns or problems with GW3-

TRBO so that we can make it a better product for everyone.   

 

Refer to the Troubleshooting & Support section of the GW3-TRBO Manual Shell (Book 600-2.3.0-AA.1) for 

complete support and contact information. 
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Document History 

Revision Description Author 

2.0.5 Initial Release JAW 
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JAW 

2.0.5 Added clarification about [LE] and [RDAC] 

activity. 

REB 

2.0.6.6 Changes before release WRK 

2.1 Changes before release KIH 

2.2 Update of Screenshots and Descriptions CWF 

2.2 Revision before release CWF 
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About this Manual 

 

Goals 

This document describes the role and function of the Activity module and 

Activity graphical user interface (GUI) within the GW3-TRBO solution. 

Who Should Read This Manual? 

This document is written for an intended audience of novice to intermediate 

MOTOTRBO system users and novice to intermediate PC users. 

How This Manual Is Organized 

This manual is organized as follows: 

¶ Overview:  Describes the basic function of the Activity module and GUI. 

¶ Advanced Options:  Describes the function of the advanced Activity 

options. 

 

This manual contains the following images, used to indicate that a segment of text 

requires special attention: 

¶  Additional Information:  Additional information is used to indicate 

shortcuts or tips. 

¶  Warning:  Warnings are used to indicate possible problem areas, 

such as a risk of data loss, or incorrect/unexpected functionality. 

Important Note 

The MOTOTRBO “backbone” that GW3-TRBO uses is a powerful stream of data 

that, as time goes by, will be revealing much more of its power. You may notice 

GW3-TRBO terms, setup options or real-time activity properties that may not 

make sense in the current MOTOTRBO world.  If you see terms, options or 

properties that are not adequately explained in your GW3-TRBO documentation, 

please contact support, look in the Glossary section of the GW3-TRBO Manual 

Shell, or on our GW3-TRBO Web site.  If you see terms, options or properties 

that you understand, but do not pertain to MOTOTRBO, please disregard them for 

the time being.  As new MOTOTRBO features are added over time, you will 

begin to understand that your GW3-TRBO is ready for those MOTOTRBO 

enhancements! 
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Chapter 1 Overview 

 
 

This chapter defines the Activity module and Activity GUI and gives instructions 

on filtering and color-coding packets. 

 

This chapter contains the following sections: 

¶ What is Activity?:  Defines the Activity module and GUI. 

¶ Monitoring Channel Activity:  Describes how to interpret the data in the 

activity list. 

¶ Customizing Channel Activity:  Describes how to customize the Activity 

GUI. 

  

 
Figure 1.1 – Activity GUI 
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What is Activity? 

The Activity GUI shows real-time activity from each GW3-TRBO input 

connection.  Through this screen you can: 

¶ Monitor channel activity. 

¶ Filter the packet types. 

¶ Assign colors to specific packet types. 

¶ Customize the font and column order of the activity list. 

¶ Suppress duplicate packets. 

¶ Pause the activity list. 

¶ Print the activity list. 

Monitoring Channel Activity 

The Activity GUI provides the activity list.  This list allows you to view stream 

activity in real time.  For a description of the type of information that can be 

received, refer to the TRBO input module book. 

 

Refer to the Troubleshooting & Support section of the GW3-TRBO Manual Shell (Book 600-2.3.0-

AA.1) for complete support and contact information. 
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Activity Values 

  The activity list contains the following columns: 

¶ Description:  Broad category of the activity (e.g. Channel Assignment, 

Call Alert, etc.).  

o Activity that is prefixed with [LE] indicates link establishment data 

that is sent only over the IP network and is not transmitted over the 

air. Such data usually is related to creating and maintaining the 

connection between GW3-TRBO and the other network peers. 

o Activity that is prefixed with [RDAC] indicates communication 

between GW3-TRBO and an RDAC connection within a repeater. 

RDAC connections grant access to repeater diagnostic information. 

¶ Group:  Target group (if any) of the activity.  

¶ Group Alias:  Alias of the target group (if there is a group).  See note on 

aliases below. 

¶ ID:  Primary radio ID (if any) of the activity. The primary ID is the source 

of a call or the radio being affected by a radio command such as an inhibit. 

For repeater-based activity, this may show the peer ID. 

¶ ID Alias:  Alias of the primary radio ID (if there is a radio ID).  See note 

on aliases below. 

¶ Type:  Activity subcategory.  Further describes the type of activity. 

¶ Target ID:  This will contain one of the following values, if the value is 

provided in the packet: 

o Target Radio ID: For call alerts, private calls, etc. 

o Requester Radio ID: For radio checks, inhibits and remote 

monitor. 

o Diagnostic Condition Description: For system diagnostics 

¶ Target ID Alias:  This will contain one of the following values, if the 

value is provided in the packet. 

o Target Radio ID Alias: For call alerts, private calls, etc.  See note 

on aliases below. 

o Requester Radio ID Alias: For radio checks, inhibits, etc. 

¶ Ch. #: This column will contain the Channel Number that the activity took 

place on. For IP connections, the Channel Number will generally be the 

repeater’s Peer ID followed by the slot number (“3-1” to indicate Peer 3, 

Slot 1).  For multisite calls, this value will show the Site-Channel-Slot 

combination for all slots on which the call occurred. (For example, “10-1-

2, 11-1-2” if the call occurred on slot 2 of sites 10 and 11.) 

¶ Ch. Freq: This column will contain the frequency of the channel the 

activity took place on.   

¶ Ch. Alias: This column will contain the alias of the channel the activity 

took place on. See note on aliases below. 

¶ Time Stamp:  The date and time when the activity was received or 

originated.  This will be the packet time stamp for packets that include a 
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time stamp.  Otherwise, it will be the date and time the packet was 

received by the input module. 

¶ Elapsed Time:  The duration of the activity.  Only Calls and Busies 

provide an elapsed time.  

¶ System ID:  The system on which the activity originated.  

¶ System ID Alias:  The alias of the system on which the activity 

originated.  See note on aliases below. 

¶ Zone  ID:  The zone on which the activity originated. 

¶ Zone  ID Alias:  The alias of the zone on which the activity originated.  

See note on aliases below. 

¶ Site ID:  The site on which the activity originated.   

¶ Site ID Alias:  The alias of the site on which the activity originated.  See 

note on aliases below. 

 

  You can view the details of an activity by double-clicking on an entry in the activity list.  

This will result in a dialog box showing every property that GW3-TRBO knows about the selected 

activity.  This functionality is also available in the Pause screen. 

 

  Aliases (ID, Group, Target Radio ID, Channel, System ID, Zone ID, Site ID) can be 

changed in the Alias GUI.  If the alias has not been changed it will appear in the appropriate 

column using the respective GW3-TRBO default GW$[ID], GW$[Group ID], GW$[System ID], 

etc., format alias. 
 

Maximizing the Activity List 

The Activity GUI allows you to resize the activity list.  To resize the activity list, 

follow the steps below: 

1. Hover over the slider bar between the Packet Types check list and the 

activity list:  This will show a resize mouse pointer. 

2. Hold down the left-click button and move the mouse up and down to 

resize the activity list. 

3. You can also double-click on the slider bar to maximize the activity list 

and hide the Packet Types check list.  To show the Packet Types check 

list again, double-click on the slider bar.  This can also be done by 

checking/unchecking the Packet Types menu option under the Filter 

menu. 
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Customizing Channel Activity 

The visual appearance of the data shown in the activity list can be customized in 

various ways.  Features such as the font, font size, columns, column order, packet 

type colors, and more can be changed.  These allow you to customize the look of 

the data to fit your needs. 

Changing Activity List Font and Size 

The font used in the activity list to display data can be customized to make certain 

the data is easily readable.  The sizes and types of monitors used to display the 

Activity GUI can necessitate different fonts or font sizes to make using and 

watching the Activity GUI easily readable.  To change the font or size, click the 

Font menu option in the View menu.  You can also display the Font window by 

right-clicking on the activity list and choosing the Font menu option from the 

menu that appears.  This will display the Font window allowing you to choose the 

Font, Font style (italic, bold, etc), font Size, among other options.  Make any 

changes desired and click the OK button to immediately see your changes in the 

activity list.  Click Cancel in the Font window to cancel any changes you made 

since opening that window 

 

 
Figure 1.2 – Font Window 

Enabling/Disabling the Green Bar 

Another feature that can be enabled is the Green Bar.  When enabled, the 

background of the rows in the activity list is alternately colored green and white.  

This allows you to easily distinguish between consecutive packets and not 

confuse the data on adjacent lines.  To enable/disable the Green Bar, either select 

the Green Bar menu option from the View menu or right-click anywhere on the 

activity list and select the Green Bar option from the menu that appears. 
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  Notice that the Group and Radio ID columns may not change to the green background color.  

If a Group or Radio ID’s background color has been changed in the Alias GUI, those colors 

assigned will be used instead.  See the Alias module book for more details on changing foreground 

and background colors for groups and radio IDs. 

Showing/Hiding Columns 

The columns shown in the activity list can be customized to hide or show only 

certain columns.  To select which columns you wish to see in the activity list, 

click the Select Columns menu option under the View menu.  You can also 

display this window by right-clicking on the activity list and choosing the Select 

Columns menu option from the menu that appears.  This will show the Select 

Columns window allowing you to check or uncheck the columns you wish to see 

in the activity list.  By default, all columns will be checked and thus will appear in 

the activity list.  Unchecking any columns in this window will hide that column in 

the activity list once you click the OK button. 

 

 
Figure 1.3 – Select Columns Window 
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Reordering Columns 

The order in which the columns are shown in the activity list can be customized 

simply by dragging and dropping the column headers.  This allows you to choose 

which columns contain the most important information or to group the 

information in a manner that is best for your needs. To change the location of a 

particular column, take the following steps: 

1. Click and drag the column header (column title) of the column you wish to 

move. 

2. Drag to the left or right until you have reached the desired position.  As 

the column is being dragged, the column you are currently over will be 

highlighted. 

3. Release the mouse button when you have reached the desired position.  

The column you dragged will be placed at the position of the currently 

highlighted column.  The highlighted column and all columns to its right 

will now be to the right of the dragged column.  All those to the left will 

continue to be to the left. 

Adding a Little Color to Your Life 

The Activity GUI allows you to color-code each packet type.  To assign a color to 

a packet type, take the following steps: 

1. Right-click on the packet type in the Packet Types list that you wish to 

assign a color to.  This will result in a color dialog box. 

2. Select the color that you wish to assign to the packet type. 

3. Click OK.  This will change the color of the selected packet type to the 

chosen color.  All activities of this packet type in the activity list will also 

change to the selected color. 

  Notice that the Group and Radio ID columns did not change to the selected color.  This is 

because these columns use the colors assigned to them in the Alias GUI.  See the Alias module 

book for more details on changing foreground and background colors for groups and radio IDs. 
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Filtering Packet Types 

The Activity GUI contains a Packet Types list that shows all known packet types.  

This list will start off empty and will add new packet types as they are received by 

GW3-TRBO.  New packet types will default to checked (included) in the Packet 

Types list.  All checked packet types will appear in the activity list as they are 

received.  Packet types that are unchecked will not be shown in the activity list. 

 

 
Figure 1.4 – Two Checked (Included) Packets 

Selecting All Packets 

Click the Select All button to select all packet types in the list.  This will show all 

activity for all known packet types. 

Unselecting All Packets 

Click the Unselect All button to unselect all packet types in the list.  This will 

exclude all activity for all known packet types, thus stopping the scrolling 

activity. 

Suppressing Duplicate Packets 

This option is only available to users that have the Disable Throttle privilege (see 

the Security module book for a detailed description of privileges).  Some input 

sources echo activity packets in triplicate and quadruplicate.  Showing more than 

one instance of each of these activities is rarely desired.  To enable/disable 

duplicate packets check/uncheck the Suppress Duplicates menu option in the 

Filter menu by clicking on that menu option. 
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Chapter 2 Advanced Options 

 
 

This chapter describes the advanced options available in the Activity GUI. 

 

This chapter contains the following sections: 

¶ Advanced Filter:  Describes how to filter packets by system ID, zone ID, 

or site ID. 

¶ Pausing the Activity List:  Describes how to create a pause window and 

the pause window options. 

¶ Activity Details:  Describes how to view the detailed information for an 

activity. 
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Advanced Filters 

The GW3-TRBO Activity GUI, by default, accepts activity from all connected 

systems, zones, sites, groups, radios and agencies.  The sections below describe 

how to filter the activity. 

 

If your activity is filtered by groups, radios or agencies, the Activity GUI will 

show a filter count and type on the right side of the menu bar.  For example, if 

your activity is filtered by 2 groups, 3 radios and 2 agencies, the menu bar will 

read: Filtered by: 2 Groups, 3 Radios and 2 Agencies. 

System Filter 

If you wish to filter the Activity GUI, based on System, Zone or Site, take the 

following steps: 

1. Click on the Advancedé menu option of the Filter menu.  This will load 

the Advanced Filters screen.  

2. Click on the System tab.  

3. Uncheck the nodes of the Systems, Zone and/or Sites that you wish to 

exclude.  Filters are applied to the scrolling data as you check/uncheck 

nodes.   

4. Click the OK button:  This will return you to the Activity GUI.  

 

 
Figure 2.1 – Advanced Filters – System Tab 

 

  This tree only contains system IDs, zone/RFSS IDs and site IDs received by the GW3-

TRBO Activity GUI.  This screen does not reference the GW3-TRBO Alias database for a list of 

these IDs.  
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Group Filter 

If you wish to filter the Activity GUI, based on group, take the following steps: 

1. Click on the Advancedé menu option of the Filter menu.  This will load 

the Advanced Filters screen.  

2. Click on the Groups tab.  

3. Click the Filter Activity by Group option.   

4. Click the Add button to add one or more groups. 

5. Click the OK button:  This will apply your filter and return you to the 

Activity GUI.  

 

 
Figure 2.2 – Advanced Filters – Groups Tab 

Radio IDs Filter 

If you wish to filter the Activity GUI, based on radio ID, take the following steps: 

1. Click on the Advancedé menu option of the Filter menu.  This will load 

the Advanced Filters screen.  

2. Click on the Radio IDs tab.  

3. Click the Filter Activity by Radio option.   

4. Click the Add button to add one or more radio IDs. 

5. Click the OK button:  This will apply your filter and return you to the 

Activity GUI.  

 

 
Figure 2.3 – Advanced Filters – Radio IDs Tab 
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Agencies Filter 

If you wish to filter the Activity GUI, based on agencies, take the following steps: 

1. Click on the Advancedé menu option of the Filter menu.  This will load 

the Advanced Filters screen.  

2. Click on the Agencies tab.  

3. Click the Filter Activity by Agency option.   

4. Click the Add button to add one or more agencies. 

5. Click the OK button:  This will apply your filter and return you to the 

Activity GUI.  

 

 
Figure 2.4 – Advanced Filters – Agencies Tab 
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Pausing the Activity List 

You may wish to pause the activity list to view a snapshot of activity data or to 

make double-clicking on a particular activity easier.  To pause the activity list, 

click the Pause menu button.  This will result in a new window.  This window 

contains the data in the activity list at the time of the pause. 

 

 
Figure 2.5 – Activity Pause Screen 
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Pause Window Options 

Opacity (available in menu only) 

Opacity measures how close a window is to solid (not transparent).  You can 

adjust the opacity of an Activity Pause screen (making it more transparent) to 

allow you to see real-time activity while viewing the Activity Pause window. 

Print (available in menu and right-click) 

Prints the Activity Pause window.  This window will print in a landscape format 

(longer horizontally than vertically).  You may need to adjust the column widths 

of the Activity Pause window to print the desired data. 

Select Allé (available in right-click only) 

Contains the following options for selecting like activity in the pause window. 

¶ Activities on the selected group:  Selects all activities with the same 

Group as the topmost selected activity. 

¶ Activities from the selected radio ID:  Selects all activities with the same 

ID as the topmost selected activity. 

¶ Activities of the selected type:  Selects all activities with the same 

Description and Type as the topmost selected activity. 

¶ Activities in the selected conversation:  Selects all activities within the 

same conversation as the topmost selected activity.  This generally 

involves packets that share a common Conversation Number or Call 

Index. 
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Activity Details 

Each activity shown in the Activity GUI contains much more information than 

what is shown in the columns of the activity list.  To view this additional 

information, take the steps below: 

1. Click the Pause button:  This will open an Activity Pause window. 

2. Double-Click on the desired packet:  This will show the Packet 

Information window, shown below. 

 

 
Figure 2.6 – Packet Information Window 

 


